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Overview

Program Features

This is a fairly complete implementation of the KERMIT communications protocol for Microsoft Windows. 
It includes most extensions to the protocol as well (Long Packets, Windowing, Server Mode, Attribute 
Packets, and Enhanced Error Checking).

Additionally, a fairly full featured terminal emulation capability is included.  The terminal emulations are 
encapsulated in Dynamic Link Libraries which allow new emulations to be added with ease.  A modem 
dialer is also included.

As do most MS Windows programs, cooperative multitasking is fully supported.  You may even have two 
copies of the program running at one time on  different serial ports!

Local Operation: Yes
Remote Operation: No
Login Scripts: No*
Transfer text files: Yes
Wildcard send: Yes (plus directory listings)
File transfer interruption: Yes
Filename collision avoidance: No*
Can time out: Yes
Eighth-bit prefixing: Yes
Repeat count prefixing: Yes
Alternate block checks: Yes
Terminal emulation: ANSI, DEC VT-102, TTY
Communication settings: Baud, Parity, Flow, etc.
Transmit BREAK: Yes
Support for dialout modems: Yes
IBM mainframe communication: Yes
Transaction logging: No*
Debug logging: No*
Session logging: No*
Raw file transmit: No*
Act as server: Yes
Talk to server: Yes
Advanced server functions: No*
Local file management: No (available from Windows)
Command/Init files: No*
Command macros: No*
File attribute packets: Yes
Extended packets: Yes
Sliding Windows: Yes

Those entries marked with an asterisk (*) are features which are expected to be available in Release 
1.00.  Unfortunately, the author has extremely limited time for this project and version 1.00 is going to 
take a while.  New releases are distributed anytime significant improvements have been made to the 
application.
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Limitations

The following limitations exist in the current version of Kermit for Windows:

• There is no scripting facility yet.

• There is no ability to direct terminal output to a printer yet.

• File handling options are currently very limited.  All received files overlay existing files and files 
are always downloaded to the current directory.

• No session logging capabilities exist yet.

Licensing Agreement

This program is distributed free of charge to anyone who has a use for it.  Please note, however, the work
is copyrighted.  Feel free to distribute the program freely, but please distribute the complete package 
(preferably as the original .zip file).

Comments and Suggestions

I always appreciate any comments or bug reports you may have.  Please send them to me via my 
Internet or CompuServe ID listed above.  I have done my best to fix all reported problems and implement 
requested enhancements.

Credits

This program is primarily the result of the comments, suggestions, and occasional compliments of the 
users.  I would especially like to thank the following individuals for their specific contributions:

Julie Bielsik created the Kermit Icon.
Matthew T. Smith created the Windows Help File.

History

Version 0.80

• Added scroll back buffer support.

• Added support for color screen attributes.

• Added TCP/IP (WinSock) Support (TELNET protocol).

Version 0.77

• Fixed a problem with the VT-102 terminal emulation: specifically the save and restore cursor 
functions were reversed.

• Added an online help file.  This file was created by Matthew Smith and is a welcome addition to 
the application.
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• The communications monitoring functions were significantly changed.  The 16-bit version now 
uses the Windows comm "notification" messages to wake up every time a character is received.  
The 32-bit version now uses overlapped asynchronous I/O.  These changes allow file transfers to
continue running even when a dialog box is displayed, or a menu item is being selected.  
Additionally, they make Kermit more friendly to other Windows apps (Kermit only hogs time when
it really needs it).

• Kermit now uses the MS 3D dialog boxes like Excel.  See the installation section for one extra 
step due to this change.

Version 0.77

• Added separate VT-102 terminal emulation with much more support for escape sequences.  
ANSI emulation is now strictly the subset that is provided by ANSI.SYS for MS-DOS (and 
therefore very appropriate for bulletin board access).

• The documentation is significantly improved (you are reading it!)

• A variety of relatively minor corrections have been made.  the most notable is the fix that allows 
you to enter a number of up to 1000 for the packet size in the Kermit Protocol configuration 
dialog (this really helps long packets work correctly!).

Version 0.75

• 2nd Place Winner in MS Windows NT Shareware Contest!!!

• Improved the look of the status and message bar areas (3D).

• Added support for Windowing extension to Kermit Protocol.

• Added user selectable terminal fonts.

• Created WIN32 version.

Version 0.71

• Added support for COM3/4:.

Version 0.70

• Modem autodialing has been added at last.

• Windows clipboard operations have also been added.  You must use review mode to use the 
Copy command.

• A generic teletype terminal emulation was added.

• All terminal emulations now fill the screen with blanks instead of nulls.  Nulls caused "some" 
Windows display drivers to behave quite strangely.

• VT-100 emulation has been enhanced some.  Keyboard application mode is now supported.  
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Ensure NumLock is on and use the numeric keypad for application mode keys.

Prerelease Version 0.60

• This version provides full compatibility with Windows Version 3.00.

• Implements a slightly nicer terminal screen with ribbon and information bars.

• A few problems in the Kermit protocol were corrected.

• The terminal emulation function has been moved to a dynamic link library.  This allows new 
terminal emulations to be created easily.

• The speed of scrolling text has been significantly increased.

Prerelease Version 0.50

This version of the program is being released so that any problems with the protocol implementation 
itself can be ironed out early.  The program is fully functional and quite usable as is.
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Getting Started

System Requirements

Kermit for Windows requires any of the existing flavors of MS Windows Version 3.1.  These flavors 
include MS Windows, MS Windows for Workgroups, and MS Windows NT.  Only the Intel variation of 
Windows NT is supported at this time.  Kermit for Windows NT appears to run fine under the current beta 
release of Windows95 as well.  Although Windows95 and Windows NT will run 16 bit applications (i. e., 
the standard 16-bit version of Kermit for Windows), it is preferable to run the NT (32 bit version).

Kermit for Windows supports both standard asynchronous (modem style) and TCP/IP (Telnet style) 
communications.

For asynchronous connectivity, Kermit for Windows relies upon the serial port drivers included with 
Windows.  I have been told that aftermarket serial drivers for Windows work fine, but have not personally 
tested this.  Support for Hayes compatible modems is also provided when using Asynchronous 
communications.

For TCP/IP connectivity, Kermit for Windows relies upon the WinSock library.  Most TCP/IP software 
vendors now support the WinSock API, so this should not be much of a constraint.  In theory all WinSock 
implementations should be compatible, but I have only tested the Microsoft WinSock libraries.  Microsoft 
includes a WinSock library with Windows NT.  They have also just released a free version of WinSock for 
Windows for Workgroups.  This free WinSock implementation can be downloaded from the Microsoft 
Software Library on CompuServe or from ftp.microsoft.com on the Internet.

The memory and hard disk requirements of Kermit for Windows are extremely small and should almost 
never be a problem.

Installation/Setup

No special installation program is provided with this software.  Installation is accomplished by simply 
creating a suitable directory and copying all files to the directory.  The original release is distributed as a 
compressed file.  Use PKUNZIP to decompress the files.

Starting with release 0.77, it is now also necessary to install a file in your Windows System directory.  If 
you are using the 16-bit version, you need to move the file CTL3DV2.DLL to your Windows System 
(usually C:\WINDOWS\SYSTEM) directory.  If you are using the 32-bit version, you need to move the file 
CTL3D32.DLL to your Windows NT System Directory (usually C:\WINNT\SYSTEM32).  If you already 
have a copy of the DLL in the target directory, check the dates and only copy the one distributed with 
Kermit for Windows if its date is more recent than the existing copy.  Either way, you MUST delete the 
DLL file from the directory in which you installed Kermit for Windows.  If you don't, you will get a nasty 
message every time you start Kermit indicating that the DLL file is incorrectly installed.

An icon can easily be added to the Windows Program Manager to provide a menu entry for invoking 
Kermit.  Follow the instructions provided with Windows for adding a program item.

You may also wish to add a line to the [Extensions] section of your WIN.INI file.  The line would look 
something like the following:

[Extensions] krm=c:\kermit\kermit.exe ^.krm
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This will allow you to start Kermit with a specific session file already loaded by double-clicking on the 
desired .KRM session file in the Windows File Manager.  Kermit will automatically be invoked with the 
selected Session File loaded.

Program Startup

You must start Windows before running Kermit.  Once Windows is running you can start Kermit by double
clicking on its icon in the Program Manager (if you installed one) or by double clicking on kermit.exe in 
the Windows File Manager.

Kermit follows all Windows standards.  Those familiar with other MS Windows applications should be 
able to use Kermit without trouble.
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Communications Sessions
In order to keep track of different sets of configuration options, Kermit uses the concept of a 
communications session.  When Kermit is first started, an untitled session is automatically initialized.  All 
configuration settings are given their default values.

In most cases, you will need to change some of the configuration options prior to establishing 
(connecting) a communications session.  See "Setting Configuration Options" for more information.

Starting a New Session

Starting a new communications session is essentially the same thing as returning Kermit to the state it 
was in when it was first started.  All configuration settings are restored to their default values.

To start a new communications session, choose New... from the File Menu.  If you have not already 
saved the settings from the existing session, you will be reminded and given the option of saving them 
now.

In order to start a new session, any existing connection to a remote system must be terminated.  If a 
connection is active at the time a new session is requested, you will be asked to confirm that you want to 
disconnect.

As a convenience, Kermit will bring up the Session Settings dialog.  This dialog allows you to enter a brief
description of the session, choose the communications type (async or telnet), choose the appropriate 
terminal emulation, and indicate if you want to automatically connect to the remote system any time this 
session is subsequently opened.  See Session Settings  for more information on this dialog.

Saving a Session

Changes made to a communications session are not kept permanently until they are saved.  When you 
save a session, Kermit will record all of the current configuration settings in a file.  You must supply a 
standard DOS filename to save the settings in.  By default the extension of the session save files is 
".KRM".

To save the current configuration settings,  choose Save or Save As... from the File Menu.  Save As... 
allows you to specify a new file to save your settings in, whereas Save will save your settings to the 
currently active session save file (as identified on the application title bar).  If there is no current session 
save file (title bar reads "(Untitled)"), then Save will function just like Save As... (it will prompt you for a file
name to save the session in).

It is not necessary to disconnect an active connection in order to save your settings.

If a session file name is required, Kermit will display the standard Windows Save As dialog.  This dialog 
functions identically to the Save As dialogs in most Windows applications.  You must type in a filename or
pick one from the list.  If no filename extension is specified, Kermit will automatically supply an extension 
of ".KRM".  It recommended that you do not use a different extension, because the Open function 
identifies session files by the ".KRM" extension by default.  Session save files may be stored in any 
directory, but the default directory is the same directory that the Kermit program is installed in.
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Opening a Saved Session

To recall a session you saved previously, choose Open... from the File Menu.  The standard Windows 
Open dialog will be displayed to allow you to choose the session save file to be opened.

By default, the Open dialog will display all files with an extension of ".KRM" in the directory that the 
Kermit program is stored in.

After choosing a session file to load, Kermit will check to see if the previous session had a connection 
active.  If so, you will be asked to confirm that you want to disconnect.  If you choose not to disconnect, 
you will be returned to the previous session with the connection still active.

If the session you have chosen to load has the Auto Connect on Open option set in the Session Settings 
dialog, Kermit will attempt to establish a connection with the remote system immediately.

It is also possible to Open a saved session at the time you invoke the Kermit program.  You may specify 
the name of a session save file on the command line that is used to invoke Kermit.  The specified session
file will be automatically loaded instead of the default settings that would normally be loaded.

If you have set up Kermit as an Icon in the Program Manager, the command line is one of the entries in 
the Properties dialog for the Icon.  This feature makes it possible to create several Icons in the Program 
Manager for Kermit and each one could start Kermit with a specific session file.
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Setting Configuration Options
In order to keep track of different sets of configuration options, Kermit uses the concept of a 
communications session.  When Kermit is first started, an untitled session is automatically initialized.  All 
configuration settings are given their default values.

Setting configuration options is done by simply using a series of dialog boxes to tailor the configuration to
your needs.  All of the configuration settings are saved as part of the Session Save File and are 
automatically restored the next time the Session is opened.

To access any of the following configuration dialogs, simply choose the corresponding item from the 
Configure Menu.

Note that the Session Settings are the most important settings.  This dialog configures the high-level  
configuration (communications type, emulation, and protocol).  Additionally, the entries in this dialog (in 
some cases) determine the options that are available in the other configuration dialogs.  For example, if 
you choose connection type async in the Session Settings, you will get options like baud rate, stop bits, 
parity, etc. in the Communications Settings Dialog.  If you choose connection type tcpip, you will get a 
different dialog that has options like host, port, etc.

Also note that certain options in the configuration dialogs may be grayed out (and therefore not 
modifiable) at certain times.  For example, the connection option in the Session Settings Dialog is grayed 
out  when a connection is currently open.  This is because it is not possible to switch to a different 
connection type without destroying the currently open connection.  To change options like these, you 
must first disconnect, and then access the appropriate dialog.

Session Settings

Name You may enter a brief (one line) 
description of the session.  This is primarily useful to 
help identify what a given session is for.

Connection A drop down list box presents all available 
connection types.  Choose async if you wish to use 
modem style communications.  Choose tcpip to use 
telnet type communications.

Emulation A drop down list box presents all available 
terminal emulation modules.  You should select the 
terminal emulation which is best suited for the remote 
system you will be connecting to.  See the section below
on Terminal Emulation if you are not sure which one to 
choose.

Protocol A drop down list box presents all available file 
transfer protocols.  At this time only kermit is supported.

Auto Connect You may check this box if you would like Kermit 
to automatically connect to the remote system when this
session is subsequently reopened (see below).
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Terminal Emulation Settings

Auto New Line Normally, a carriage return control character will
only move the cursor to the first position on the current 
line.  If this option is selected, a carriage return 
character will also advance the cursor to the next line.

Local Echo Normally, characters you type at the keyboard 
are sent only to the remote system and the remote 
system "echoes" them back.  It the remote system does 
not echo typed characters, select this option to cause 
typed characters to be displayed on the terminal screen 
and sent to the remote system.

Auto Line Wrap If this option is selected and too many 
characters are received to fit on the current line, the 
cursor will automatically advance to the first position of 
the next line when the last position of a line is used.

Communications Settings - Async

Baud Rate Enter the baud rate that you wish to use to 
communicate with the remote system or the speed your 
modem requires.  Although you are allowed to enter any
value, only 300, 1200, 2400, 4800, 9600, 19200, 38400,
and 57600 should be used.  Additionally, Windows will 
not support the higher baud rates with some types of 
serial port hardware.

Word Length Also known as data bits.  Usually 8, but 
occasionally 7.  The administrator of the system you are 
trying to connect with should be able to give you this 
information.

Parity Normally none, but again the 
administrator of the remote system should be able to 
supply this information.  Note that N=None, E=Even, 
O=Odd, M=Mark, S=Space.

Stop Bits Number of stops bits required by the remote 
system.  Almost always 1.

Handshake Kermit for Windows supports two types of "flow 
control".  Xon/Xoff uses control characters to prevent 
buffer overruns.  RTS/CTS uses two specific lines 
(wires) on the serial port to achieve the same effect.  
Which option is appropriate depends on your modem 
configuration and remote system requirements.

Port Kermit for Windows support COM ports 
1 through 4 (if available).  Although all 4 selections are 
always shown, your computer probably doesn't have all 
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four.  Be sure to choose a port that exists and is 
available and properly configured under Windows.
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Communications Settings - TCP/IP

Host Enter the internet host name you wish 
to connect to (like microsoft.com) or the internet address
to connect to (like 129.193.208.56).

Port Enter the name or number of the 
TCP/IP service port to use.  This entry is almost always 
telnet and should only be changed if you are sure you 
understand the use of non-standard ports.

NOTE: although it is called a "port", this 
is nothing like a "serial port".  A TCP/IP port has no 
connector on the back of your PC, it is a logical port.

Terminal Most Telnet host servers have the ability to read
the terminal type of the users machine at connection 
time.  To enable this feature, you must specify the name 
of the terminal type you wish to provide to the host.  
Kermit for Windows will provide this name to the host if 
it requests it.

NOTE: this entry does NOT determine 
the type of emulation that Kermit for Windows will 
perform (that is determined by the Emulation setting in 
the Session Configuration Dialog).  This entry should 
correspond to a name that your host understands and 
will associate with the type of emulation you have 
already chosen in the Session Configuration Dialog.

Send CR LF for End of Line If you are attempting to talk to a non-standard telnet 
service, the host may require both a CR and LF control 
code at the end of every input line.  If you don't 
understand this option, you probably don't want to use it.

Suppress Negotiation The Telnet protocol requires that the client and 
host "negotiate" certain configuration settings at startup.
In rare cases you may want to disable this negotiation.
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Device Settings

Connection Type of connection desired.  Dial and answer 
apply to modems.  If no modem is in use, you should 
choose direct.  If dial is chosen, a phone number to dial 
should be supplied.

Dial Init The sequence of characters that should
be send to the modem to initialize it for dial-out usage..  
The default is usually OK.

Dial Cmd The sequence of characters that should be sent
to the modem to cause it to dial a phone number.  The 
default is usually OK.

Answer Init The sequence of characters that should be 
send to the modem to initialize it for answer usage.  The
default is usually OK.

Hangup The sequence of characters that should be 
send to the modem to cause it to hang up the phone 
line.  The default is usually OK.

Escape The sequence of characters that should
be send to the modem while online prior to sending 
command strings.

Connect The message that the modem will send when a 
connection has been successfully established.

Redial Number of times to redial a number that
fails to connect followed by the number of seconds to 
wait between attempts.

Wait Number of seconds to wait from the 
time a number is dialed to get a successful connection 
message.
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Protocol Settings

Packet Size Size of data packets in bytes desired for send 
and receive.

Timeout Number of seconds to wait before assuming a 
lost packet for send and receive.

Retry Limit Maximum number of retries before aborting 
protocol.

Block Check Kermit provides three different error detection 
block check types.  Block Check Type 1 is the least 
reliable and Block Check Type 3 is the most reliable.

Debug Select debugging options as desired.  
Packet option will display packets sent/received.  State 
option will show state of protocol engine at various 
points.  Other is undefined.

Options Check the appropriate boxes  for advanced 
Kermit protocol functions.  Attrib will allow file 
information attributes to be used.  L. Pkts will allow 
packet sizes up to 1000 bytes.  Windows will allow the 
sliding windows extension to be used (Super Kermit).

Packets... This button invokes a nested dialog that allows 
special customization of various Kermit packet 
characters.  It is not normally needed.

Options... Not implemented.

Font Settings

Font Select from the list of available fonts.  
Only "fixed-pitch" fonts will be displayed.  If a font called 
"Terminal" is available, it is recommended because it is 
specifically designed to work with communication 
programs.

Size Point size for font.  A larger point size 
means a larger font displayed on the window.

Sample A sample display of the currently 
selected font.

Note that after changing the selected 
font, Kermit will attempt to resize the terminal window to 
provide a full 80 by 25 display.  If the window can not be 
expanded enough to do this, scroll bars will be 
displayed.
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When a new session is created, Kermit 
requests a default fixed-pitch font from Windows.  In 
some cases (depending on your display driver and 
resolution), windows does a poor job of selecting a 
default font.
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General Operation

Connecting/Disconnecting

To initiate a connection, choose Connect from the Session Menu.  If you selected "Call" on the Device 
Dialog, the modem will dial the number you entered.
If you chose Auto Connect, in the Session Dialog, Kermit will automatically attempt to connect when the 
session is opened.

When you are connected, the online timer in the upper right of the display will increment.  A check mark 
will be placed next to Connect in the File Menu as well.

To disconnect, just choose Connect from the Session Menu again.  You will be disconnected and the 
check mark will be removed.

Scrollback/Clipboard Operations

Kermit for Windows provides an 800 line scrollback buffer to review text that has scrolled off the screen.  
Additionally, you can select any of the text in the scrollback buffer   to copy to the Windows Clipboard for 
pasting into other applications.

In order to access the scrollback buffer and the clipboard copy function, you must first set Review Mode.  
Review Mode simply suspends all communications activity (sending or receiving of data).  It can be very 
difficult to select or review text while data is being received since the text is moving while you are trying to
read  and/or select it.  By invoking review mode, the current text in the scrollback buffer is frozen 
temporarily so you can easily review and select it.

To invoke review mode you can choose Review from the Edit Menu or just press the Pause key.  The 
scroll bars will be adjusted appropriately and a message will be displayed in the message bar indicating 
you are in Review Mode.  

When in review mode, you may use the mouse or keyboard to select text.  Using the mouse, click and 
drag the mouse to select an area on the screen.  To use the keyboard, hold down the shift key and use 
the arrow/pg keys to select an area on the screen.  Once the area is selected (shown as inverted text), 
choose Copy from the Edit Menu to copy the selected data to the clipboard.

One you are done reviewing and/or copying text to the clipboard, be sure to terminate Review Mode so 
you can resume sending and receiving data.  You can terminate Review Mode by pressing the Pause or 
Escape keys or by choosing Review from the Edit Menu again.

Kermit for Windows also provides the ability to paste text from the clipboard.  Text pasted is automatically
transmitted down the currently open communications device.  Essentially, the paste function allows you 
to send text in the clipboard to the host.  If the host is capturing text (in an editor for example), you could 
then save the transmitted text on the host.  This provides a simplistic text transfer function.

Unlike the Copy function, the Paste function is enabled only when you are NOT in review mode and there
is an active connection.  This is because the paste function must send the clipboard data down the 
communications channel.  In review mode (or when there is no active connection), this is not possible 
and the Paste command will be grayed out.

To paste data from the clipboard to the terminal, choose Paste from the Edit Menu.  Note that the Paste 
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command is only available when the clipboard contains text.

Application Window Areas

The Kermit application window is contains a terminal window as well as a status bar and a configuration 
bar.

The status bar appears at the bottom of the application window and provides an area to display context 
sensitive, single line help on the left and the current date and time on the right.

The configuration bar appears at the top of the application window and displays various information about
the currently selected configuration.  From left to right, the following information is shown: connection 
type, terminal emulation, protocol, communication settings, and time online.

The time online indicator is initialized to 00:00:00 and will start incrementing once a connection is made.  
When a connection is terminated, the time online for the previous connection is displayed until a new 
connection is requested.  Note that, some of the fields on the configuration bar will not be displayed in the
application window is shrunk too small to accommodate all of them.

The middle area of the application window contains the terminal emulation window.  If the terminal 
emulation window is too small to display 80 characters by 25 rows, then scroll bars will be displayed as 
appropriate to allow scrolling to view data that is off the edge of the window.

When the size of the application window is changed by the user, the terminal emulation window 
automatically tries to adjust the size of the font being used to continue to show a full 80 columns by 25 
rows.  Scroll bars will only be displayed if the selected font can't be shrunk enough to fit completely in the 
size of the window provided.

As characters are received when online, the terminal window will automatically scroll to "follow" the 
cursor.  This ensures that the area of the screen where characters have last been displayed will always 
be visible.
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Terminal Emulation

Kermit currently provides three different types of terminal emulation.  These include dumb terminal 
(teletype), ANSI (like ANSI.SYS), and DEC VT-102 (like a DEC VT-102 CRT Terminal).

Selecting a Terminal Emulation

Because Kermit is designed to allow for terminal emulations to be added as separate modules, it is 
necessary to select the terminal emulation module.  The terminal emulation module is selected from the 
Session Dialog (NOT from the Terminal Configuration Dialog).  The Session Dialog presents a list of the 
available terminal emulation modules (files with an extension of .TRM).

Scroll Back Buffer Operation

An 800 line scroll back buffer is maintained during a session.  To scan back through lines that have 
scrolled off the screen, you must activate Review Mode.  Review Mode suspends communications 
activity and allows you to scroll through previous lines.  Communications is suspended because it would 
be very hard to scroll back through old data if it were changing as you tired to find what you were looking 
for.

To activate review mode, chooses Review from the Edit Menu or press the <Pause> key.  You can now 
use the scroll bars, arrow keys and paging keys to review the buffer.  When you are done, be sure to 
press <Esc> or choose Review from the Edit Menu again to restore communications.

Teletype Terminal Emulation

Teletype Terminal Emulation is provided as a bare minimum terminal emulation.  If simply echoes 
received characters to the screen as received.  Other than carriage return, line feed, and form feed, it 
does not respond to any special escape sequences.  This emulation type is appropriate when the data 
being received contains no special screen formatting commands.
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ANSI Terminal Emulation

ANSI Terminal Emulation implements the same screen formatting commands as the ANSI.SYS device 
driver that is provided with MS-DOS.  This emulation is very popular with dial-up bulletin boards.
If the bulletin board attempts to send IBM graphics, you should be sure to select the "Terminal" font 
(using the Font Dialog).  The Terminal font contains the IBM graphics extended character set.  Most other
Windows fonts use the ANSI character set which does not include the IBM graphics characters.
This terminal emulation does not support sending escape sequences for any keyboard function keys.
The following escape sequences received from the remote computer are handled:

Function Escape Sequence
CURSOR POSITION SET <ESC>[<r>;<c>H
CURSOR POSITION SET <ESC>[<r>;<c>f
CURSOR MOVE UP <ESC>[A
CURSOR MOVE DOWN <ESC>[B
CURSOR MOVE RIGHT <ESC>[C
CURSOR MOVE LEFT <ESC>[D
ERASE TO END OF SCREEN <ESC>[0J
ERASE FROM START OF SCREEN <ESC>[1J
ERASE ENTIRE SCREEN <ESC>[2J
ERASE TO END OF LINE <ESC>[0K
ERASE FROM START OF LINE <ESC>[1K
ERASE ENTIRE LINE <ESC>[2K
READ CURSOR POSITION <ESC>[6n
SAVE CURSOR POSITION <ESC>[s
RESTORE CURSOR POSITION <ESC>[u
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DEC VT-102 Terminal Emulation

DEC VT-102 Terminal Emulation implements the screen formatting commands found on the ever popular 
DEC VT-102 terminal.  This emulation is frequently used by UNIX dial-up systems and by some bulletin 
boards.

Due to the character set selection feature of this terminal emulation, it is desirable to select the Windows 
"terminal" font when using this emulator.

The remote (host) computer controls whether the VT-102 keyboard is in numeric or application mode.  
Numeric mode is entered at startup.  The following escape sequences will be sent for numeric keyboard 
mode:

VT-102 Keyboard IBM PC Keyboard Escape Sequence
PF1 F1 <ESC>OP
PF2 F2 <ESC>OQ
PF3 F3 <ESC>OR
PF4 F4 <ESC>OS
UP ARROW UP ARROW <ESC>[A
DOWN ARROW DOWN ARROW <ESC>[B
RIGHT ARROW RIGHT ARROW <ESC>[C
LEFT ARROW LEFT ARROW <ESC>[D

The following escape sequences will be send for application keyboard mode:

VT-102 Keyboard IBM PC Keyboard Escape Sequence
PF1 F1 <ESC>OP
PF2 F2 <ESC>OQ
PF3 F3 <ESC>OR
PF4 F4 <ESC>OS
UP ARROW UP ARROW <ESC>OA
DOWN ARROW DOWN ARROW <ESC>OB
RIGHT ARROW RIGHT ARROW <ESC>OC
LEFT ARROW LEFT ARROW <ESC>OD
KEYPAD 0 KEYPAD 0 <ESC>Op
KEYPAD 1 KEYPAD 1 <ESC>Oq
KEYPAD 2 KEYPAD 2 <ESC>Or
KEYPAD 3 KEYPAD 3 <ESC>Os
KEYPAD 4 KEYPAD 4 <ESC>Ot
KEYPAD 5 KEYPAD 5 <ESC>Ou
KEYPAD 6 KEYPAD 6 <ESC>Ov
KEYPAD 7 KEYPAD 7 <ESC>Ow
KEYPAD 8 KEYPAD 8 <ESC>Ox
KEYPAD 9 KEYPAD 9 <ESC>Oy
KEYPAD - KEYPAD - <ESC>Om
KEYPAD , KEYPAD * <ESC>Ol
KEYPAD . KEYPAD . <ESC>On
KEYPAD ENTER KEYPAD + <ESC>OM
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The following escape sequences received from the remote computer are handled:

Function Escape Sequence
ANSWER SEQUENCE TO REQUEST <ESC>[<l>;<c>R
BACKSPACE ^H
CARRIAGE RETURN ^M
CHARACTER DELETE <ESC>[<n>P
CHARACTER INSERT <ESC>[<n>@
CURSOR MOVE DOWN <ESC>[B
CURSOR MOVE LEFT <ESC>[D
CURSOR MOVE RIGHT <ESC>[C
CURSOR MOVE UP <ESC>[A
CURSOR POSITION SET <ESC>[<l>;<c>H
CURSOR POSITION SET (ABSOLUTE) <ESC>[<l>;<c>f
CURSOR RESET <ESC>[8
CURSOR SAVE <ESC>[7
ERASE ENTIRE LINE <ESC>[2K
ERASE ENTIRE SCREEN <ESC>[2J
ERASE FROM START OF LINE <ESC>[1K
ERASE FROM START OF SCREEN <ESC>[1J
ERASE TO END OF LINE <ESC>[0K
ERASE TO END OF SCREEN <ESC>[0J
ESCAPE <ESC>
IDENTIFY <ESC>Z
INDEX <ESC>D
INDEX REVERSE <ESC>M
KEYPAD APPLICATION <ESC>=
KEYPAD NUMERIC <ESC>>
LINE DELETE <ESC>[<n>M
LINEFEED ^J
LINE INSERT <ESC>[<n>L
NEXT LINE <ESC>E
READ CURSOR POSITION <ESC>[6n
READ STATUS <ESC>[5n
RING BELL ^G
APPLICATION KEYBOARD MODE <ESC>[h1
CURSOR KEYBOARD MODE<ESC>[l1
SET SCROLLING REGION <ESC>[<t>;<b>r
TRANSMIT DEVICE ATTRIBUTES <ESC>[c
CHANGE G0 CHAR SET UK <ESC>[A
CHANGE G0 CHAR SET US ASCII <ESC>[B
CHANGE G0 CHAR SET TO GRAPHICS <ESC>[0
CHANGE G0 CHAR SET (ALT CHAR) <ESC>[1
CHANGE G0 CHAR SET (ALT GRAPHICS) <ESC>[2
CHANGE G1 CHAR SET UK <ESC>[A
CHANGE G1 CHAR SET US ASCII <ESC>[B
CHANGE G1 CHAR SET TO GRAPHICS <ESC>[0
CHANGE G1 CHAR SET (ALT CHAR) <ESC>[1
CHANGE G1 CHAR SET (ALT GRAPHICS) <ESC>[2
SELECT G0 CHAR SET ^O
SELECT G1 CHAR SET ^N
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Kermit Protocol Operation

To initiate a Kermit operation, you must first be connected (see above).  A variety of Kermit commands is 
available from the Protocol Menu.  Send and receive are the most common.  They are used to send and 
receive files.  Choosing send displays a dialog to choose files to be sent -- multiple files may be chosen 
to send in one operation.  Choosing receive immediately attempts to begin receiving a file (the partner 
computer should begin sending).

Several advanced Kermit protocol operations are supported as well.  Each of the various Kermit functions
is invoked from the Kermit Menu:

Send... Send a file or group of files to the 
remote computer.

Receive Receive file(s) from the remote computer.

Server Initiate Kermit Server mode on the local 
computer to allow the remote computer to make 
requests.

Get... Request specific file(s) from the remote 
computer.

Host... Invoke a command on the remote 
computer.

Generic Invoke standard Kermit commands on the 
remote computer.

Note that both the Host and Generic commands require that the partner computer be in server mode.
While any Kermit operation is in progress, the items in the Kermit Menu change to the following:

Cancel File Terminates the sending or receiving of the 
current file cleanly.  A partially received file will be 
erased.  A partially sent file will be handled by the 
remote computer depending on its settings.

Note that this function terminates the 
sending/receiving of only the current file.  Kermit will 
continue to send/receive any additional files that are 
part of the batch.

Cancel Batch Terminates the sending or receiving of the entire
batch of files being processed.

Stop Attempts to terminate any Kermit 
protocol operation cleanly.

Abort Terminates any Kermit protocol 
operation immediately.  The remote computer may be 
left in a "funny" state.
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Retry Requests that the current packet be 
resent immediately.  Normally a packet will be resent 
after the specified timeout period has expired.

Prior to invoking a Kermit operation, you must be connected to a remote computer.  You must also 
ensure that your Protocol Settings are correct for the remote computer you are connected to (see the 
section on Setting Configuration Options).

Like this one, most Kermit programs have a wide variety of configuration options.  Although Kermit will 
generally "negotiate" a mutually acceptable set of working options with the remote computer, there are 
some settings which you may need to make on both computers.

The most critical option is generally referred to as the "File Type" by most Kermit programs.  Be sure to 
set the file type on the remote computer to text or binary based on the type of files you will be 
transferring.  Note that Kermit for Windows does NOT have a setting for this because MS-DOS text files 
do NOT need special handling as they do under other operating system.  If your files appear garbled after
a file transfer, check the file type setting on the remote computer.

Despite popular belief, Kermit can usually transfer text or binary files FASTER than any other protocol 
(including ZModem)!  However, you must enable certain extended features on both the local and remote 
Kermit program (Kermit defaults to a set of options that almost guarantee a transfer will work, but very 
slowly).  The most important options to enable are Sliding Windows (use about 4 slots) and long packets 
(packet size of 1000 or so).  Use the Protocol Settings Dialog in Kermit for Windows to configure these 
options.  Setting these options on the remote computer will depend on the version of Kermit being used.  
Unfortunately, many popular off-the-shelf communications programs don't bother to implement all these 
extensions (just enable the ones  that are available).

Sending Files

Prior to initiating the send operation from Kermit for Windows, you must tell the remote computer to 
prepare to receive the files you send.  With Kermit, this can be done two ways.  Either invoke the Receive
or Server function on the remote computer.

Choose Send... from the Kermit Menu.  The Send Files Dialog will appear.  The Send Files Dialog is 
somewhat more complex than the ones in other communications programs because Kermit has the 
ability to send arbitrary batches of files using a list of file specifications (specifications may include wild 
cards).

In the File Selection area of the dialog, enter or select a file you wish to send and choose Add.  The 
selected file will be added to the Send Queue at the top of the dialog box.  You may also enter a file 
specification that includes wild cards (* and ?).

You may also use a wild card specification to specify a group of files to be DISPLAYED in the selection 
window by entering a wild card specification and choosing list.  You may then choose the specific files 
you want to add.

Additionally, it is possible to select multiple individual files from the selection window by holding down the 
control or shift key as you click on the files you want to select.  Be sure to choose Add after selecting the 
desired files to add them to the Send queue.  If you hold down the control key and click, you will select 
just the files you actually click on.  If you hold  down the shift key and click, you will select all files 
between the currently selected file and the file you click on.
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If you wish to remove files from the Send Queue, you may select the files to be removed in the Send 
Queue Window and choose Delete.

When you have added all the desired file specifications to the Send Queue, choose Send.  The standard 
Kermit Protocol Status Window will display the progress of your transfer.
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Receiving Files

Prior to initiating the Receive operation, you must tell the remote computer to send the desired files.  This
is accomplished differently depending on the version of Kermit being used by the remote computer.
After initiating a Send operation on the remote computer, choose Receive from the Kermit Menu.  The 
standard Kermit Protocol status Window will display the progress of your transfer.

Unfortunately, the current version of Kermit for Windows still isn't very smart about handling received 
files.  It will overwrite any file with the identical name as it is received.  Also, no checking is done for 
available disk space.  When Kermit runs out of disk space for files being received, the protocol will abort 
in an ugly way with a cryptic error message.

Server Operation

Server operation can be invoked by choosing Server from the Kermit Menu.  Kermit will display the 
standard Kermit Protocol Status Window and wait for commands from the remote computer (like send, 
get, etc.)

At this time, Kermit for Windows supports only a few server functions (although they are the most 
important ones: get, send, and type.  This list will be significantly expanded in the near future.

Requesting Files from a Remote Kermit Server

You may request files from a remote computer funning Kermit in Server Mode by choosing Get from the 
Kermit Menu.  A dialog is displayed requesting the names of the files to be requested from the remote 
computer.  You may enter multiple file specifications separated by a apace character.  Each file 
specification may be a single file or a wild card specification.

Invoking Commands on Remote Kermit Host

Some Kermit programs allow you to request the execution of commands on the remote computer.  The 
remote computer must first be running Kermit in Server Mode.  Then choose Host... from the Kermit 
Menu.  A dialog will be displayed  to allow you to enter the text of the command to be executed on the 
remote computer.

If the command string entered can be executed on the remote computer. then the results of the command
will be displayed on the local Kermit for Windows terminal window.

Requesting Generic Functions on Remote Kermit Host

If a remote computer is running Kermit in Server Mode, then it may support various predefined generic 
functions.  The remote computer must first be running Kermit in Server Mode.

Choose Generic... from the Kermit Menu.  A dialog will be displayed that allows you to select the generic 
function you wish to perform on the remote computer (such as a directory listing, who is on, etc.).  There 
are three lines to enter supplemental information for the generic command request.  Fro example, if you 
selected the dir function, you could specify name of the directory in the first text box.  Unfortunately, this 
version of Kermit is not very user friendly about showing you what each of the text boxes can be used for 
with each of the generic functions.

Choose OK to invoke the generic function.  If the remote computer is able to handle the requested 
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function, the output of the function will displayed on the Terminal Window of the local Kermit for Windows.
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